
 Microsoft Word 
           Basics 

 
Course Objective 
 

In these two sessions, participants will be introduced to the 
basic features of Microsoft Word 2003.  Participants will have 
hands-on experience with such features as highlighting, 
modifying text, cutting and pasting, use of spell and 
grammar check, and saving to a storage location.   
 

 
Course Overview 

Introduction to the Microsoft 
Word Screen 

Options To Format the 
Document 

Typing Text and Formatting  Microsoft Word Terms 
Formatting the Document  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Introduction to the Microsoft Word 2003 Screen 
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Views of the Microsoft Word Screen 
 
Top of Microsoft Word Screen 
 
 
 
Title Bar   Menu Bar     Tool Bars   Ruler                           Minimize  Maximize   Close 
 

 
                                                                                      Help Field 
 
 
 
Title Bar: tells you the name of the Application/Program Open. 
 
Menu Bar: drop down Menus of Commands, Functions Buttons. 
 
Tool Bar: most Frequently Used Commands, functions and Options. 
 
Ruler: indicates the margins of the page and tab stops. 
 
Minimize Button: places the Open Application/Program on the 
Windows Task Bar. 
 
Maximize Button: enlarges the Application/Program to fit the entire 
desktop. 
 
Close Box: closes the Application, Program or File that is open. 
 
Help Field: a field to type a question by using keywords or terms to 
search Microsoft Word help. 
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Side of the Microsoft Word Screen 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Up Arrow: moves the text up the page.  
 
Scroll Bar Box: moves text up and down the page. 
 
Scroll Bar: the bar at the right edge of the screen that allows up and 
down movement of text. 
 
Down Arrow: moves the text down the page. 
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     Up Arrow 

Down Arrow 
Previous Page 
Select Browse Object 
Next Page 



Previous Page: if you have more than one page in your document, 
the button will move you back a page. 

 
Select Browse Object: this button allows you to choose an object, 

icon, file or folder for manipulation of the text or 
document. 

 
Next Page: if you have more than one page in your file, the button 
will move you forward a page. 
 
 
 
 
 

Bottom Half of Microsoft Word Screen 

 
                                     Bottom Scroll Bar    Drawing  Tool Bar     Status  Bar 

 
 

Views: Normal View   Web Layout View   Page Layout View    
Outline View  Reading Layout View  are different views in which 
to see the page of text. 
 
Drawing Tool Bar: adds shapes and drawings to the document. This 
tool bar opens at the bottom of the screen above the Status Bar. 
 
Status Bar: indicates the length of the document in page number, 
number of pages, section line, and column. These change as the 
cursor moves on the page. 
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Right Mouse Button 
 

 
 
The menu on the above Microsoft Word Screen is an example of using 
the Right Mouse Button.  Depending on the task and application you 
are working on, the right mouse button will offer different options.  In 
the example above, the right hand mouse button offers text-
formatting options. 
 

 
 

In the Excel example above, the right hand mouse button offers cell-
formatting options, which differ from the Microsoft text formatting 
options. 
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Visuals When Typing Text 
 

 
 

 
 

Blinking Cursor: is the point on the document where text can be 
typed 
 
Ibar: is the coworker of the Cursor.  The Ibar is your mouse.  If you 
move your mouse, the Ibar will move. The Ibar helps move the 
Cursor to parts of the text screen, calls the Cursor into a blank field, 
and works with the Cursor in text formatting, such as highlighting. 
 
Arrow:  the Ibar becomes an arrow if you move your mouse onto the 
Tool or Menu Bar. 
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Blinking 
Cursor 

I Bar with shadow. 



Text and Formatting Text 
 

 Correcting text with the Ibar and Cursor. 
 Using Spell Check 
 Learning to Highlight 
 Making text changes with highlighting 

o centering text 
o size of font 
o type of font 

 Moving text up and down on page 
 Dragging Text  
 Undo with edit 
 Save to location 
 Print preview 
 Print 

 
Please type: 
 
 

First Part Microsoft Word 
 
The First Part of Microsoft Word will teach us the 
options available in Microsoft Word to increase our 
skill of word processing. 
 
This is just the beginning of the wonderful world of 
Microsoft Word. 
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Correcting text with the Ibar and Cursor 

 

 
 

The Ibar is placed where the correction is to be made. It is preferred 
to place the Ibar to the right of the letter to be deleted and the 
Backspace key used instead of the delete key. The Delete key is 
located right below the Insert key on the keyboard. The Insert key 
may be turned on when the Delete key is used. This can cause a lot of 
problems when you are typing and it is accidentally turned on. 
 
Move the mouse (the Ibar when in text) to the place where you want 
to make a change. Once the Ibar is in place, click the left mouse 
button and the blinking cursor moves to the same place with the 
Ibar. At this point you can move the Ibar (the mouse) away from the 
blinking cursor by clicking in another location with the mouse. With 
the blinking cursor in place, use the Backspace key to delete the 
letter or letters or a new letter can be inserted at this point. 
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Spell Check 
 
Spell Check is the first option under the Tools Menu. 
 

 
 

Spell Check and Grammar are on the same menu. As you type text, if 
a word becomes underlined in red that means the word is misspelled. 
If a word, words or string of words is underlined in green that means it 
is a spatial or grammar problem. 
 
Spelling and Grammar menu   spelling error in red print. 

 
              Highlight the correct suggestion and click on the Change button. 
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Highlighting 
 

 Highlight by making the cursor active after the text you would like 
to highlight. 

 Keep the blinking cursor and the Ibar together.   
 Keeping the mouse button pressed, slide to the left over all of the 

words and then let go of the mouse.  All the words should be 
highlighted in a black shadow.  Remember use your left hand 
mouse button only. 

 

 
 
 

 
 
The text was centered on the page by highlighting and clicking on the 
Center Button located on the Tool Bar. 
 
Clicking on any button on the Tool Bar can change highlighted text. 
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Moving text up and down on the page. 
 

Place your blinking cursor (not the Ibar) in front of the text that will 
be moved down the page. 
 

 
 
Using the enter key on the keyboard… 
 

 
 

enter several times and the text will move down the paper. 
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Now using the backspace key  press a few times and the text 
will move up the page. The backspace key will stop working when the text has 
moved up to the top line of the paper. 
 

 
 
Dragging Text 
 

 
 

Sometimes when highlighting, the mouse goes into the mode to drag 
text.  The mouse becomes an arrow with a small box attached that 
indicates the drag text mode.  When the mouse is in the drag text 
mode, text can be moved to another part of the screen. 
 
 
 

©Ann Arbor District Library                                                                                         12

 



Undo 
 
UNDO is found under the Edit menu or by the back arrow located on 
the Tool Bar. 
 

 
 
 
 
 
By selecting either option the text will return to its original position. 
 

 
 
UNDO under Edit will undo the last action made. When using the arrow 

on the toolbar a small down arrow is next to the arrow icon . The 
down arrow will show a list of the most recent actions you can undo. 
When you undo an action, all actions in the list can be undone. 
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Saving Work to a storage device. 
 
Work can be saved to a storage device, 3½ floppy disk, flash drive, 
CD, or the C:\ of the computer. Save As can be found under File on 
the Menu Bar. 
 

 
 

Once the Save As menu is opened the computer has to be directed to 
the location where it should be saved. 
 

1. The Save In field shows the location where to save. If it 
does not show where the file should be saved the small 
down arrow will bring up other locations which can then 
be selected.   

 

 
 

2.  A file name has to be given to the document. 
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3. Once the file is named, click on the Save button.  
 

 
 

4. A side frame gives options that can be clicked on to direct 
the computer. 

 
 

 
 
 
 
It is best the name of the file should be short and without spaces. 
Numbers can be used, but not punctuation marks. The computer will 
automatically add a period (.) and the proper extension. Microsoft 
Word uses the doc extension. 
 
If saving to a floppy disk the a:\ drive should be identified. If the 
computer has a CD drive, that needs to be identified. Usually the letter 

is d or e:\ . 
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The other most common storage device is the thumb or flash drive. 
 

 
 

The thumb drive (also known as jump drive or flash drive) is inserted 
into the USB port of the computer. When using the thumb drive, 
when the SAVE AS menu comes up, instead of identifying the A:/ drive 
in the SAVE IN field, you will identify the USB port. The computer will 
recognize a device has been inserted into the USB port.  You will also 
give the file a name in the FILE NAME field and click the SAVE button 
to complete the save. 
 
Print Preview 
 
Print Preview is a way of looking at your document as it is laid out. 
Print Preview gives the option of looking at the document as it will be 
printed before printing. Print Preview is found under the File on the 
Menu Bar. 
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Print Preview opens a window showing your document and a toolbar 
that has options for working with the preview. One of the options is to 
Close out of the preview window. 
 

 
 

Printing 
 
Usually the next step after Print Preview is printing the document. 
Print is found under File on the Menu Bar under the Print Preview 
option.   
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On the Print window there are the options of printing all of a file, 
current page, and individual pages. If more than one copy is made, 
there is also the option to collate the pages according to page 
numbers. The final step is to click the OK button to have the printing 
begin. 
 
Select All 
 
Select All is found under EDIT on the Menu Bar. Select All highlights all 
the text with one click.  
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Once all of the text is selected the text can be edited, deleted or 
reformatted. If you have all of the text selected and a keystroke is 
made, the entire text will be deleted. Remember UNDO will bring back 
the last action that was made. 



Formatting the Document 
 

Open the Application 
From the Word Screen 

 Open up msword from the saved location 
 Go to Page Setup 

 
Page Setup 
 
PAGE SETUP through the use of tabs allows margin changes, selection 
of papers size, paper source and layout, The text and page will 
automatically adjust to the changes made. However, when Microsoft 
Word opens as a new document, it opens with all the default settings. 
 

 
 
Page Setup will bring up a window with three tabs. 
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Margins 
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     Paper 

Layout 



Using the Page Setup menu, let’s make changes to the document. 
 

 Change left and right margins from 1.25” to 3.00” 
 Preview the changes 
 Close out of the file 
 Open a new document 

 
Let’s type: 
 

The Second Part of Microsoft Word will teach us the 
skills of: 
 

Cut and paste 
Spell check 
Formatting 
 

First we must learn about: 
 

The cursor and pointer 
Where text begins 
Highlighting 
 
 
 
 
Options to Format the Document 

 

 Paragraph Options 
 Cut and Paste (move the two paragraphs) 
 Bullets and Numbered Lists 
 Page Breaks 
 Draw (only if time permits) 

 
Paragraph Options 
 
The PARAGRAPH OPTIONS can be found under the menu FORMAT 

©Ann Arbor District Library                                                                                         21

 



 
 
The two tabs under PAGRAPH OPTIONS allow Indents, Line Spacing 
and inserting Page Breaks. Page Breaks can also be found under the 
Insert Menu. 
 
Indents and Spacing               Line and Page Breaks 

 
 

 
Single, double or 1.5 line spacing can be found under the Indents and 
Spacing tab. Highlight the text to be spaced and select line spacing. 
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Lines can also be spaced by keyboard shortcuts.  The keyboard 
shortucts are: Ctrl+1 for single space; Ctrl+2 for double spacing; and 
Ctrl+5 for 1.5 line spacing.  Leave the cursor active in the text and use 
the shortcuts. 
 
Cut, Copy and Paste 
 
CUT, COPY AND PASTE can all be found under EDIT 
 

 
 

Once the text is highlighted and COPIED, it can either be PASTED 
to another document or PASTED to another part of the same 
document. 

Once the text is highlighted it can be CUT from the document 
entirely and PASTED to another document or to another part of 
the same document. 
 
There is a difference between CUT and COPY.  If you highlight text 
and CUT, the original text is gone and on the clipboard of the 
computer to be PASTED.  If you highlight text and COPY, the 
original text is still in place and also on the clipboard of the 
computer to be PASTED. 

 
To CUT, COPY or PASTE 
 
 highlight the text to be copied or pasted 
 go up to File on the Menu bar. 
 slide down to COPY or CUT (at this point Paste is grayed out) 
 place your cursor where you want the text to be (either in the same 

document or another document) 
 go up to File on the same document or File of the other document 
 at this point, PASTE will be your only option. 
 click on PASTE 
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Cut 
Copy 
Paste 



Bullets and Numbering 
 

BULLETS AND NUMBERING is found under the FORMAT Menu 
 

 
 

When the Bullets and Numbering menu comes up there are several options 
available. 
 
 

 
 
Adding bullets or numbering to a document can be done in several ways. You 
can type the text that you would like to add the formatting to, highlight the text 
and click on either the Bullets or Numbering menu or click on the formatting first 
by selecting from the Bullets or Numbering menu or the icons on the Tool Bar 
and then add the text.  
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Once the formatting has been applied the bullets or numbering will continue until 
the option is turned off. The option can be taken off by clicking on: 
 
 
Click on the None option on the Bullets and Formatting menu. 
 

.  
 

Click off the icons on the Tool Bar.   or 
 

entering two returns.   
 
If more than one list is made in a document, the second list can be a continuation 
of the first list or can be renumbered from one. 
 

 
 
 

©Ann Arbor District Library                                                                                         25

 



Page Breaks 
 
PAGE BREAKS can be found under the INSERT MENU. 
 

 
 

A dialogue box comes up to select the type of break. 
                

 
 

When the break is selected the view of the document will change 
depending whether you are in Normal or Print Layout view. 
             
           Print Layout View 
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Normal View 

 
 

Drawing Toolbar 
 

 
 

 
 
 

When the Drawing Toolbar is selected, the toolbar usually appears at 
the bottom of the Microsoft Word screen.  To use the tools, click on the 
tool you want to use, move to the text area of the Word screen.  The 

mouse turns into cross (+), instead of an arrow or an I Bar.   Holding 
down the left mouse button, the selected image can be drawn. 
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Microsoft Word Terms 
 

Blinking Cursor:  is the point on the document where text can be 
typed. 
 
Close Button: closes the Application, Program or File that is open.  
The Close Button is found on the right side of the Title Bar with the 

Minimize and Maximize Buttons.   

 
Copy:  text that is highlighted can be copied and placed in another 
part of the document or in an entirely different document.  The Copy 
function is found under Edit. 

 
Cut:  text that is highlighted can be cut and placed in another part of 
the document or in an entirely different document.  The Cut function is 
found under Edit. 
 
Dragging Text: when text is highlighted, clicking on the left button of 
the mouse while moving the mouse will drag the text to a different 
part of the document.  A small box attached to the cursor indicates the 
dragging text mode.  The text is dropped where the cursor is when 
you release the mouse button.                                                                  

 

Highlighting: is done by placing the cursor near the text that needs 
to be formatted, and sliding over the text with the IBar. Once 
highlighted, the text appears against a black background, and 
formatting such as changing the letter size and style can be applied. 

 
IBar:  is the coworker of the Cursor.  The IBar helps move the Cursor 
throughout the text screen, calls the Cursor into a blank field for 
typing, and works with the Cursor when highlighting. 
 
Menu Bar:  contains all of the Commands and Options that are 
available in Microsoft Word. 
 
Maximize Button: enlarges the open window to cover the desktop. It is located 

in between the Minimize and Close Button.   
 
Minimize Button:  places the open Application/Program window on 
the Windows Task Bar.  The Windows Task bar is at the bottom of the 
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Maximize Button 

Close Button 



screen where the Start button is located.  The Minimize Button is found 
on the right side of the Title Bar with the Maximize and Close Buttons. 

 
 
Paste:  the text that has been copied is held in the memory of the 
computer, called the clipboard.  The clipboard holds the text and 
allows the Paste command to place the text where indicated. 
 

Previous Page, Select Browse Object and Next Page: are buttons 
that can be found below the Scroll Bar on the right side of the screen.  
The Previous Page and Next Page allows for the movement from one 
page to the next in a large document or file.  The Select Browse Object 
allows you to choose an object, icon, file or folder for manipulation of 
the text or document. 

 
Print Preview:  takes the document and displays it at a distance so 
the layout of the document can be seen before printing.  The Close box 
will take you back to the text for any changes that need to be made. 
 
Ruler:  the Ruler, located below the Menu and Toolbar, indicates the 

margins of the page and the tab stops. 
 

Title Bar:  the Title Bar displays the names of the Application/Program 
that is Open.  The Title Bar is located at the very top of 
the Microsoft Screen and is blue. The Minimize, 
Maximize and Close button are also located on the right 
hand side of the Title Bar. 

 
Tool Bar:  shows small icons of the most frequently used  commands,   

function or options.  This bar can be customized to 
display the buttons that are used most often. 

 
    Scroll Bar:  the Scroll Bar is located on the right side of the Microsoft 

Word screen.  The Scroll Bar has Up and Down Arrows 
and a Scroll Bar Box.  The Arrows and Scroll Bar Box 
allow for the up and down movement of text on a page.  
Most software screens have a right side scroll bar. 

 

    Select All:  highlights all of the text with one click for editing 
purposes.  Select All is found under the Edit Menu.    
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 Minimize Button 
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Status Bar:  indicates the length of the document in pages, the page, 
section, line, and column the cursor is on. 
 
Undo and Redo: the Undo and Redo options are found under the Edit 

Menu. They may also be found on the Tool Bar, as 
icons displaying curved arrows. The Undo button will 
bring back any formatting changes that were made.  
For example, if you changed a font and wanted the 
original font again, the Undo button will change the 
font back.  If the second font turns out to be better, 
the Redo button will change the font again.   

 
Views:  there are three different ways the Microsoft Screen can be 

seen.  Normal Views brings you the whole screen without 
showing the gray areas of the margins.  The Online/Web 
Layout shows the screen as it would with the parameters of 
the Internet. The Page /Print Layout shows the screen with 
the margins in gray, showing how the page would look when 
printed. 
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